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Course Description:

This module exposes students to the depth and breadth of modern programming practice,
with the goal of making students better programmers. It is, however, an advanced level
module in which some advanced programming concepts are taught.

Course Objectives:

This module aims to introduce the students to some concepts of software testing and
practice on reusing components. The major objectives of Software testing are as follows:
e Finding defects which may get created by the programmer while developing the
software. Gaining confidence in and providing information about the level of quality.
e To prevent defects.
e To make sure that the end result meets the business and user requirements.
e To ensure that it satisfies the BRS that is Business Requirement Specification and

SRS that is System Requirement Specifications.
To gain the confidence of the customers by providing them a quality product



S. No.

List of Experiments

Hands on Software Engineering principles Infrastructure.

usage of Front-end and Back-end technologies and packages

Prepare the following documents for three of the experiments listed below

using software engineering methodology.
1. Program Analysis and Project Planning.
2. Thorough study of the problem — Identify project scope, Objectives,

3. Software requirement Analysis

Describe the individual Phases / Modules of the project, Identify deliverables

Software Design

a. Use work products — Data dictionary, Use case diagrams and activity

diagrams,
build and test class diagrams,
b. Sequence diagrams and add interface to class diagrams, DFD, ER diagrams

c. Software Development and Debugging using any Front end and Back end

tool

d. Software Verification and Validation procedures
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EXPT NO :-1
Understand The Automation Testing Approach (Theory Concept)
Automation
Automation is making a process automatic eliminating the need for human intervention. It
is a self-controlling or self-moving process. Automation Software offers automation wizards
and commands of its own in addition to providing a task recording and re-play capabilities.
Using these programs you can record an IT or business task.
Benefits of Automation
Fast
Reliable
Repeatable
Programmable
Reusable
Makes Regression testing easy

Enables 24*78 Testing

Robust verification.
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Automation Test Workflow

[Prepare ’ ‘ Create ’ I‘ Verify &Enhance ’ || Integrate
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INTRODUCTION TO SELENIUM
1. History of Selenium
 In 2004 invented by Jason R. Huggins and team.
+ Original name is JavaScript Functional Tester [JSFT]

 Open source browser based integration test framework built originally by
Thoughtworks.

100% JavaScript and HTML

Web testing tool

That supports testing Web 2.0 applications

Supports for Cross-Browser Testing(ON Multiple Browsers)

And multiple Operating Systems

Cross browser — IE 6/7, Firefox .8+, Opera, Safari 2.0+

2. What is Selenium?

Acceptance Testing tool for web-apps

Tests run directly in browser

Selenium can be deployed on Windows, Linux, and Macintosh.

Implemented entirely using browser technologies -
JavaScript
DHTML
Frames

3. Selenium Components

— Selenium IDE

— Selenium Core

— Selenium RC
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— Selenium Grid

3.1 Selenium IDE

The Selenium-IDE (Integrated Development Environment) is the tool

you use to develop your Selenium test cases.

It is Firefox plug-in

Firefox extension which allows record/play testing paradigm
Automates commands, but asserts must be entered by hand
Creates the simplest possible Locator

Based on Selenese

3.1.1 Overview of Selenium IDE:

A.Test Case Pane
B. Toolbar
C.Menu Bar

D.Log/Reference/Ul-Element/Rollup Pane

A. Test Case Pane:

e Your script is displayed in the test case pane.
e It has two tabs.
e one for displaying the command (source)

e and their parameters in a readable “table” format.

Command | selectWindow | =
Value '

B. Toolbar: The toolbar contains buttons for controlling the execution of your

test cases, including a step feature for
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C. Menu Bar:

o File Menu: The File menu allows you to create, open and save test case

and test suite files.

o Edit Menu: The Edit menu allows copy, paste, delete, undo and select all

operations for editing the commands in your test case.

e Options Menu: The Options menu allows the changing of settings. You
can set the timeout value for certain commands, add user-defined user
extensions to the base set of Selenium commands, and specify the format

(language) used when saving your test cases.
D. Help Menu:
Introducing Selenium Commands

The command set is often called selenese. Selenium commands come in three
<« »
flavors”:

Actions, Accessory and Assertions.
a. Actions: user actions on application / Command the browser to do
something.

Actions are commands that generally manipulate the state of the

application.
1. Click link- click / Clickandwait
2. Selecting items

b. Accessors: Accessors examine the state of the application and store the

results in variables, e.g. "storeTitle".
c. Assertions: For validating the application we are using Assertions
1. For verifying the web pages
2. For verifying the text

3. For verifying alerts
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Assertions can be used in 3 modes:
e assert
o verify
e waitFor
Example: "assertText","verifyText" and "waitForText".
NOTE:
1. When an "assert" fails, the test is aborted.
2. When a "verify" fails, the test will continue execution
3. "waitFor" commands wait for some condition to become true

Commonly Used Selenium Commands

These are probably the most commonly used commands for building test.
open - opens a page using a URL.

click/clickAndWait - performs a click operation, and optionally waits for a

new page to load.
verifyTitle/assertTitle - verifies an expected page title.
verifyTextPresent- verifies expected text is somewhere on the page.

verifyElementPresent -verifies an expected Ul element, as defined by its

HTML tag, is present on the page.

verifyText - verifies expected text and it’s corresponding HTML tag are present on
the page.

verifyTable - verifies a table’s expected contents.
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waitForPageToLoad -pauses execution until an expected new page loads. Called

automatically when clickAndWait is used.

waitForElementPresent -pauses execution until an expected Ul element, as

defined by its HTML tag, is present on the page.

3.1.2 Recording and Run settings

When Selenium-IDE is first opened, the record button is ON by default.
During recording, Selenium-IDE will automatically insert commands into your
test case based on your actions.

a. Remember Base URL MODE - Using Base URL to Run Test Cases in Different Domains

b. ReCOI'd A.bSO].ute recording mOde — Run Test Cases in Particular Domain.

3.1.3 Running Test Cases

Run a Test Case Click the Run button to run the currently displayed test case. Run
a Test Suite Click the Run All button to run all the test cases in the currently
loaded test suite.

Stop and Start The Pause button can be used to stop the test case while it is

running. The icon of this button then changes to indicate the Resume button. To
continue click Resume.

Stop in the Middle You can set a breakpoint in the test case to cause it to stop on a

particular command. This is useful for debugging your test case. To set a
breakpoint, select a command, right-click, and from the context menu select
Toggle Breakpoint.

Start from the Middle You can tell the IDE to begin running from a specific

command in the middle of the test case. This also is used for debugging. To set a
startpoint, select a command, right-click, and from the context menu select
Set/Clear Start Point.

Run Any Single Command Double-click any single command to run it by itself.

This is useful when writing a single command. It lets you immediately test a
command you are constructing, when you are not sure if it is correct. You can
double-click it to see if it runs correctly. This is also available from the context
menu.

Test Suite:
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A test suite is a collection of tests. Often one will run all the tests in a test suite as

one continuous batch-job.

When using Selenium-IDE, test suites also can be defined using a simple HTML

file. The syntax again is simple. An HTML table defines a list of tests where each

row defines the filesystem path to each test.

Installing the IDE

Using Firefox, first, download the IDE from the SeleniumHQ downloads page

Firefox will protect you from installing addons from unfamiliar locations, so

you will need to click ‘Allow’ to proceed with the installation, as shown in the

following screenshot.

g' SeleniumHQ

eb application t

Projects QELLIILELE Documentation Support About

Downloads
Selenium Downloads & z -
Below is where you can find the latest releases of all the Selenium projects. You
Previous Releases can also find a list previous releases, nightly releases, source code, and
Nightly Releases additional information for Maven users (Maven is a popular Java build tool)
Source Code Project Release Date Version
Selenium Core June 10, 2009 1.0.1 Download | Changelog
Maven Repository 7 P z 4
Info Selenium IDE Nov 5, 2010 1.0.8 Download | Release Notes
Selenium RC  February 23, 2010 1.0.3 Download
Selenium Grid April 8, 2010 1.0.6 Download (zip) | Changelog
CubicTest Nov 10, 2008 1.8.11 Download | Changelog
Bromine July 25, 2010 3.0 RC 2 Download
Selenium 2 April 22, 2010 2.0 alpha 5 Download

Plugins for Selenium IDE

Stopped

f D
@ Downloads - Moxilla Firefox =
File Edit View History Bookmarks Tools Help
» c Q W http://seleniumhg.org/download/ g ‘-"~ Google r
=
& Downloads [ o+

When downloading from Firefox, you’ll be presented with the following window.

Global Institute of Technology, Jaipur
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Software Installation

Install add-ons only from authors whom you trust.

S Malicious software can damage your computer or violate your privacy.

You have asked to install the following item:

selenium-ide-1.0.8.xpi (Author not verified)
http://release.seleniumhg.org/selenium-ide/1.0.8/selenium-ide-1.0.8 xpi

| Instal Nw\& | Cancel |

Select Install Now. The Firefox Add-ons window pops up, first showing a

progress bar, and when the download is complete, displays the following.

@ Add-ons

2k 4 Al

Get Add-ons  Extensions Themes Plugins  Installation

@ Restart Firefox to complete your changes.

Restart Firefox

@y~ SeleniumIDE 108
€ | Restart to complete the update.

Restart Firefox. After Firefox reboots you will find the Selenium-IDE listed

under the Firefox Tools menu.

Global Institute of Technology, Jaipur
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Selenium Downloads
Previous Releases
Nightly Releases
Source Code

Maven Repository
Info

s"e) Seleniuml Adblock Plus Preferences... Ctrl+Shift+E

@ Downloads - Mosilla Firefox [ESE>X)
File Edit View Higtory Bookmarks Help
- C X A (@] Webserch CtileK 2% -] [$8~ Goo )
Qw—‘ Downloads Ctrl+) =
e [ | Ao =
Error Console Ctrl+Shift+) I

mentation Support About 3

es of all the Selenium projects. You
eleases, source code, and
h is 3 popular Java build tool).

Page Jnfo
D & Selenium IDE
4
Bel Start Private Browsing Ctrl+Shift+P
el
cal Clear Recent History... Ctrl+ Shift+Del
ad(  options...
Project Release Date Version
Selenium Core June 10, 2009 1.0.1
Selenium IDE Nov 5, 2010 1.0.8
Selenium RC  February 23, 2010 1.0.3
Selenium Grid April 8, 2010 1.0.6
CubicTest Nov 10, 2008 1.8.11
Bromine July 25, 2010 3.0RC2

Selenium 2 April 22, 2010 2.0 alpha 5 Download

Plugins for Selenium IDE

Name Author License

Download | Changelog
Download | Release Notes
Download

Download (zip) | Changelog
Download | Changelog
Dowinload

Released Version

14

Done

Opening the IDE

To run the Selenium-IDE, simply select it from the Firefox Tools menu. It opens

as follows with an empty script-editing window and a menu for loading, or

creating new test cases.

-
@& Selenium IDE 1.0.8

File Edit
Base URL

Dptions Help

ia ST Slow bE D__
Table | source

Command Target

Walue

TRl

Target

Walue

Cormmand

]- Log | Reference I UI-Element I Rollup

Infor Clear|
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EXPT NO:-2 Using Selenium IDE, Write a test suite containing minimum 4 test

cases.
TC’S #1: Manual Steps:

* Open (Example : Type www.google.com)
* Type “energy efficient” in the Google Search Input Box
» Click outside on an empty spot
* Click Search Button
* Verify the Text Present as “energy efficient”
» Assert the Title as “energy efficient - Google Search”
» Save the test case with .HTML Extension.
TC’S #2:

* Open (Example : Type www.google.com)

«  Type “Selenium RC” in the Google Search Input Box
» Click outside on an empty spot

* Click Search Button

« Verify the Text Present as “Selenium RC”

+ Assert the Title as “Selenium RC - Google Search”

+ Save the test case with .HTML Extension.

Steps for creating test suite:

1. Create more Tc’s save each Test Case with <.html> extension.
2. Open Firefox

3. Open Tools = Selenium IDE

4. File > Open > new Test Suite

5. File & Open = Add Test cases

6. Add more test cases

7. Save Suite with <.Html> extensions.

8. Run the test suite
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EXPT NO:-3 Conduct a test suite for nay two web sites.
TC’S #1: Manual Steps:

* Open (Example : Type www.google.com)

* Type “energy efficient” in the Google Search Input Box
* Click outside on an empty spot

* Click Search Button

* Verify the Text Present as “energy efficient”

 Assert the Title as “energy efficient - Google Search”

+ Save the test case with .HTML Extension.

TC#2:
1: Open Firefox Web Browser
2: In the address bar, Type http://www.yahoo.com
3: In the search input button, Type "energy efficient"
4: Click on the "Web Search" submit button
5: Wait for Search Results to come on "http:/search.yahoo.com"

6: Verify "energy efficient" text is present anywhere in the search results:
(Select and

highlight anywhere in the search results page, "energy efficient" text is

present.)

7: Verify the browsers title has the value "energy efficient - Yahoo! Search
Results"

8. Save the test case with .HTML Extension.
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Steps for creating test suite:

1. Create more Tc’s save each Test Case with <.html> extension.

2. Open Firefox

3. Open Tools = Selenium IDE

4. File > Open = new Test Suite

5. File > Open - Add Test cases

6. Add more test cases

7. Save Suite with <.Html> extensions.

8. Run the test suite

Global Institute of Technology, Jaipur
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Selenium-RC

1. Introduction

Selenium-RC is the solution for tests that need more than simple browser
actions and linear execution.

Selenium-RC uses the full power of programming languages to create more
complex tests like reading and writing files, querying a database, emailing
test results.

You’'ll want to use Selenium-RC whenever your test requires logic not
supported by Selenium-IDE.

What logic could this be? For example, Selenium-IDE does not directly support:
* condition statements

* iteration

* logging and reporting of test results

- error handling, particularly unexpected errors

* database testing

* test case grouping

* re-execution of failed tests

* test case dependency

- screenshot capture of test failures

Although these tasks are not supported by Selenium directly, all of them can be
achieved by using programming techniques with a language-specific Selenium-

RC client library.
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EXPT NO :-4 Install Selenium server and demonstrate it using a script in

Java/PHP

Installation of Selenium RC and Eclipse

Download Eclipse

Go to URL - http://www.eclipse.org/downloads/

A e

Click on OK button and save to a local drive (i.e. C: or D, etc)
Unzip the downloaded zip file and rename that to Eclipse

Create one more folder “Eclipse-Workspace” (i.e. C:Eclipse-

Select Eclipse IDE for Java Developers (Click on Windows 32 bit platform)

Workspace)in the same drive where Eclipse is unzipped and renamed.

6. Create Eclipse desktop shortcut (go to C:Eclipse folder —> right click

Eclipse.exe and then click on “desktop create shortcut”) as demonstrated

in the below pictures.

Global Institute of Technology, Jaipur
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A A

Now we need to create a workspace folder —>
C:Eclipse-WorkspaceSeleniumTests

Double click on “Eclipse shortcut on Desktop”

This opens the Eclipse

Close Eclipse welcome screen

Click File menu —> Switch Worspace —> other

Now Select the C:Eclipse-WorkspaceSeleniumTests folder (These steps

are demonstrated in the following figure)

We have finished setting up the eclipse. Now, we need to download Selenium RC

server / client driver and configure that to Eclipse

1. Download Selenium server: http://seleniumhq.org/download/

Download Selenium Client driver for Java (from Selenium Client Drivers
section)
Create “Selenium” folder in C: drive and copy the Selenium-server.jar

as well as unzip the Selenium Client driver (C:Selenium)

Downloading and unzipping the files into a folder is done. We need to configure

the appropriate Selenium Client driver Jar file to the Eclipse.

1.

Go to Eclipse —> Click File —> New —> Project (from various options need to
select just “project”)
In Select Wizard —> Click Java —> “Java Project” (demonstrated in the

below figure)
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. PO Rt U~ v @ A RS e
RESSNN e —T) -
LT
e —
=

3. Give the project name (e.g. SugarCRMTests)

4. Click Finish — Click Yes

5. Now we are done with creation of project and need to configure
the Selenium Client driver to this Project

6. Right Click “SugarCRMTests” project

7. Click “Java Build Path”

8. Click Libraries tab

9. Click “Add External JARs” button

10. Select “Selenium Client Drivers” unzipped in C:Selenium folder
(Selenium Server JAR file should not be added)

11.Click OK

12. Referenced libraries —> contains both the Selenium Client driver jar files

as shown in the below picture.
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First script-Selenium RC-JUnit-Java

Selenium RC allows to write the automated tests in any language. Selenium Scripts

can be written in various ways:

1. Extending the Selenese Test Case
2. Extending the TestCase-Junit and defining an object to the
DefaultSelenium Class

Before you start with your script, the following are the steps that should
be performed.

Methodl: Extending the Selenese Test Case

1. Install any IDE (Eclipse, Intelli], IDEA), create a project.

2. Download the selenium RC file from Selenium website.

3. Extract the selenium-remote-control-1.0.3.zip file and add the
selenium-remote-control-1.0.3\selenium-java-client-driver-
1.0.1\selenium-java-clientdriver.jar and selenium-remote-control-
1.0.3\selenium-server-1.0.3\selenium-server.jar file to the build path.

4. Create a new package and a class in the newly created package.

5. Copy the below code:

import
com.thoughtworks.selenium.SeleneseTestCase; public
class SeleniumTest1 extends SeleneseTestCase { public
void setUp() throws Exception {
setUp("http://www.hexbytes.com/", "*firefox"); }
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public void testNew() throws Exception{
selenium.open("/");

selenium.type("searchbox", "selenium rc");
selenium.click("css=input[type='submit']|[value='Search']");
selenium.waitForPageToLoad("30000");

assertTrue(selenium.isTextPresent("selenium rc"));

}
}

6.Start the selenium Server.

7.Click on the RunAs button and run the script as JUnit Test. If you
don’t find the option Install the JUnit plug-in and run the script.

Method2: Extending the DefaultSelenium Class.
Some times we need the selenium scripts to contact the server running on a
different port and different machine. You can configure the selenium scripts to
handle such situations easily by extending your selenium script from
TestCase(Junit) and defining the selenium instance as an object to DefaultSelenium
class.
package test;
import junit.framework.”;
import com.thoughtworks.selenium.DefaultSelenium;
public class DefaultSelenium1 extends TestCase{
private DefaultSelenium selenium; public void
testing(){
selenium=new
DefaultSelenium("localhost",4444,"*iexplore","http://hexbytes.com");
selenium.start();
selenium.open("/");
selenium.type("searchbox", "selenium rc");
selenium.click("css=input[type='submit'|[value='Search']");
selenium.waitForPageToLoad("30000");

Assert.assertTrue(selenium.isTextPresent("selenium rc"));

}
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EXPT NO:-5 Write and test a program to login a specific web page.

import com.thoughtworks.selenium.*;
import org.junit.After;

import org.junit.Before;

import org.junit.Test;

import java.util.regex.Pattern;

public class exp5 extends SeleneseTestCase
{ @Before
public void setUp() throws Exception {
selenium = new DefaultSelenium("localhost", 4444,

chrome", "http://demo.opensourcecms.com/");

LLE]

selenium.start();

@Test

public void testExp5() throws Exception {
selenium.open("/wordpress/wp-login.php");
selenium.type("id=user_login", "admin");
selenium.type("id=user_pass", "demo123");
selenium.click("id=wp-submit");

selenium.waitForPageToLoad("30000");

@After
public void tearDown() throws Exception

{ selenium.stop();

Global Institute of Technology, Jaipur
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TestNG

TestNG is a testing framework inspired from JUnit and NUnit but introducing

some new functionalities that make it more powerful and easier to use, such as:

« Annotations.

o Run your tests in arbitrarily big thread pools with various policies
available (all methods in their own thread, one thread per test class, etc...).

o Test that your code is multithread safe.

o Flexible test configuration.

o Support for data-driven testing (with @DataProvider).

o Support for parameters.

o Powerful execution model (no more TestSuite).

o Supported by a variety of tools and plug-ins (Eclipse, IDEA, Maven, etc...).

o Embeds BeanShell for further flexibility.

o Default JDK functions for runtime and logging (no dependencies).

o Dependent methods for application server testing.

TestNG is designed to cover all categories of tests: unit, functional, end-to-end,

integration, etc...
Installing TestNG in eclipse

o Select Help / Software updates / Find and Install.
o Search for new features to install
o New remote site.

For Eclipse 3.4 and above, enter http://beust.com/eclipse.

For Eclipse 3.3 and below, enter http://beust.com/eclipsel.
o Make sure the check box next to URL is checked and click Next.

« Eclipse will then guide you through the process.
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Launching your tests in Eclipse

o We finished writing our tests, now how can we run them?
You can launch TestNG from the command line, using a Eclipse plugin
or even programatically. We are going to use the Eclipse plugin. Follow
the steps described on the official TestNG documentation over here

o Ifyou installed TestNG correctly, you will see this menu when you
right click on the XML file:

LTI 7 ! TestNG Suie
Debug As )
Team y  Run Configurations...

o Click on “Run as TestNG Suite” and your test will start running. You

will then see this nice results tree:
|= ¢ Problems 7@ Javadoc Eg‘, Declaration ,E‘TQ,S.I.NQ 3 E Console| [ ] Properties

Tests: 0/1 Methods: 7/7 (52324 ms) | = Passed: 7

[t All Tests | 'z Failed Tests == Failure Exception
'ﬂ; Knorrium.info - Wordpress Demo ( 7/0/0/0 )
v gl Write new post ( 7/0/0/0)

&_]test.\Vordpress.launchSite()

E’iijtesLWordpress.openAdminPage()

E’}:jtest.\Vordpress.loginAsAdmin()

&Ejtest.\Vordpress.navigateNewPostO

IJ'TJtest.\Vordpress.wri(eBIogPostO

&jtest,\Nordpress.publishBlogPos(()

il test.Wordpress.verifyBlogPost0Q

Selenium Tests with Microsoft Excel

Parameterizing a test from external sources such as Microsoft Excel is always
recommended in order to handle large amount of test data. To read data from
Excel, we need APIs which support opening file, reading data, and writing data
into Excel. We should know various classes and methods which support above
mentioned operations. In this post, let us try to figure out which is the API that

supports all the activities we need to do during execution of a test.

Jxl.jar is an open source Java API which supports read Excel spreadsheets and
to write into Excel spreadsheets. Below are some of the operations that we can
handle with this API.

1. Read data from Excel spreadsheet
2. Read and write formulas into spreadsheets

3. Generate spreadsheets
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4. Supports formatting of font, number, and date

5. Supports coloring of cells

To access the methods and classes provided by this API inside Eclipse we need to
add this JAR file to the Java Build Path. (I have explained steps to add external Jar

files to Java Build Path in previous posts)

Download the jxl.jar from “Attp.//jexcelapi.sourceforge.net/”

Add the JAR file to Java Build Path

Add import statements to the .java file as below to read from an Excel spreadsheet
import jx1.Cell;

import jxl.Sheet;

import jxl. Workbook;

import jxl.read.biff. BiffException;
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EXPT NO :-6 Write and test a program to update 10 student records into table

into Excel file .

import java.io.FileInputStream;
import java.io.FileOutputStream;
import jxl.Sheet;

import jxl. Workbook;

import jxl.write.Label;

import jxl.write. WritableSheet;
import jxl.write. WritableWorkbook;
import org.testng.annotations.”;

public class newj {

@BeforeClass

public void setUp() throws Exception {}

@Test

public void testImportexport1() throws Exception {
FileInputStream fi = new

FileInputStream("D:\\exp6.xls"); Workbook w =

Workbook.get Workbook(fi); Sheet s = w.getSheet(0);

String a[][] = new String[s.getRows()][s.getColumns()];
FileOutputStream fo = new FileOutputStream("D://exp6Result.xls");
WritableWorkbook wwb = Workbook. create Workbook(fo);
WritableSheet ws = wwb.createSheet("result1", 0); for (inti=0;1 <
s.getRows(); i++)

for (int j = 0; j < s.getColumns(); j++)

{
a[i][j] = s.getCell(j, i).getContents();
Label 12 = new Label(j, i, a[i][j]);
ws.addCell(12);
Label 11 = new Label(6, 0, "Result");
ws.addCell(11);
}

for (inti=1;1i < s.getRows(); i++) {

Global Institute of Technology, Jaipur
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for (int j = 2; j < s.getColumns(); j++)

{
a[i][j] = s.getCell(j, i).getContents();
int x=Integer. parselnt(a[i][j]);
if(x > 35)
{
Label 11 = new Label(6, i, "pass");
ws.addCell(11);
}
else
{
Label 11 = new Label(6, i, "fail");
ws.addCell(11);
break;
}
}

}

wwb.write();

wwb.close();

}
}
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INPUT

@ = s N exp6.xls [Compatibility Mode] - Microsoft Excel I
= | Home L Insert Page Layout Formulas Data Review View =2 X

EE & ‘Callbn 52 =1 | General ﬁ @ Einse g ‘1 ﬂ m

Ay @" Delete

e e o Zoler) B R [ g
‘Chpbaavd = \ Font Alignment | Number I' Styles Cells Editing
[ 6 -Q ¥
[ [N T = S T S Y RN Y~ [ T Y RN Y - —
1 |rolinc Names BMSIC JAVA wp total
2 1 ganesh 62 85 64 211
| 3 2 praveen 62 62 64 188
4 | 3 pandurang 30 36 40 106

S 4 rohan 50 55 25 130 g |
&= s abc s 20 3 114 [ 1 1
B 6 qwgew 90 75 89 254
L
=

15

4 4 » »| Sheetl - Sheet2 ~ Sheet3 ~¥J "

Ready |

OUTPUT

N B N C exp6Result.xls [Compatibility Mode] - Microsoft Excel R N
A
N | Home l Insert Page Layout Formulas Data Review View = 4
[E * \Anal EA‘ % | General > ﬁ @ a‘:lnsert' ﬂ ﬁ
= - Delete ~
Paste - = Z§ E _ - - .9 <0 .0 Condrhonal Format Cell Sort & Find &
- [317 7'9'—” |§ Il B l 5 ks I‘ -~ s’ ing ~ as Table ~ Styles ~ EBFW'"“' 2' Filter~ Select~
\cnpboard \ Font | Alignment i) Number = Styles Cells Editing
| Al ~@ £ | rolino ¥
o B | .c. . |.b L E L FE . J 6 . H | b J.J . K. ] [ m [ N [ o [y
rollno !Names BMSIC JAVA WP total Result
1 ganesh B2 "85 64 211 pass
¢ praveen 62 62 64 "188 pass
3 pandurang 30 "36 40 "106 fail
rohan i
T h 50 55 25 "30 fail
5 abc 45 20 49 114 fail
G qwgew 30 75 89 254 pass

< » M| resultl <%

Ready |
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EXPT NO :-7 Write and test a program to select the number of students who

have scored more than 60 in any one subject ( or all subjects ).

import java.io.FileInputStream;
import java.io.FileOutputStream;
import jxl.Sheet;

import jx1. Workbook;

import jxl.write.Label;

import jxl.write. WritableSheet;
import jxl.write. WritableWorkbook;
import org.testng.annotations.;

public class exp7 {

@BeforeClass

public void setUp() throws Exception {

}

@Test

public void testImportexport1() throws Exception {
FileInputStream fi = new

FileInputStream("D:\\exp6.xls"); Workbook w =
Workbook.get Workbook(fi); Sheet s = w.getSheet(0);

String a[][] = new String[s.getRows()][s.getColumns()];
FileOutputStream fo = new FileOutputStream("D://exp7Result.xls");
WritableWorkbook wwb = Workbook. create Workbook(fo);
WritableSheet ws = wwb.createSheet("result", 0); int c=0;

for (inti = 0; i < s.getRows(); i++) {
for (int j = 0; j < s.getColumns(); j++)

{

ifi >= 1)
{

String b= new String();

b=s.getCell(3,i).getContents();
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if( x < 60)
{

C++;

break;

a[i][j] = s.getCell(j, i).getContents();

ws.addCell(12);

}
}

wwb.write();

wwb.close();

}
}

Label 12 = new Label(j, i-¢, a[i][j]);

INPUT

‘6% H9 © expb.xls [Compatibility Mode] - Microsoft Excel g =i
= tome: [ Pagelayout  Formulas  Data  Review  View @ - x
:-j : Calibi o AN E S | General ﬁ ﬁ 9‘ ;::':;1: ;]: %7 -‘ﬁ
R g ||| vl | e e e T sy | EFomat~ || O ir Set~
Clipheard Font i Alignment Number Styles cells Editing

5 e & ¥
A B c D G H . G M N o i

1 rolino  Names BMSIC  JAVA WP
2 1 ganesh 62 8 64 211
3 2 praveen 62 62 64 188
4 3 pandurang 30 36 40 106

5 4 rohan 50 55 P 130 1|
§ 5 abc s 2 8 14 [ 1 1
7 6 qwoew % s 89 254
8
9

10

1

12

13

1

15
W 4> M| Sheetl Sheet2 “Sheet3 ¥J &

Ready

[EEE o=
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A0S e ©
W

OUTPUT

#* rial
Lj\_:’;aA[

exp7Resultxls [Compatibility Mode] - Microsoft Excel -
| Home [ Insert Page Layout Formulas Data Review View @ - o x
=F  General - % % [

Salnsert~ | X -
e I AP

™ Delete ~

ad~ || Y <0 .00 iti i -
|2 | e (18wl ) S e ses - || B Format || 2~ Prers ceecs
|Clipboard | = Number = Styles | cens Editing |
[ M15 [¥]
A [ B [ C | D [ E [ ¢ [ H . T [ K [ L ol W o |y
1 |roline Names BMSIC  JAVA WP total
2N ganesh B2 "85 54 211
S ,'2 praveen 62 52 54 "188
4% qwgew 80 "5 "89 "254
5
B
7
8 3
£93)
10
n
12
13
L 14|
15
16
47)
18] i
M 4> ¥ result <¥J
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EXPT NO :-8 Write and test a program to provide total number of objects present
/ available on the page .

package testscripts;
import com.thoughtworks.selenium.*;
import org.openqa.selenium.server.*;

import org.testng.annotations.”;

public class exp8 {
public Selenium selenium;

public SeleniumServer seleniumserver;

@BeforeClass

public void setUp() throws Exception {

RemoteControlConfiguration rc = new RemoteControlConfiguration();
seleniumserver = new SeleniumServer(rc);

selenium = new DefaultSelenium("localhost", 4444, "*firefox","http://");
seleniumserver.start();

selenium.start();

}

@Test
public void testDefault TNG() throws Exception {

selenium.open("http://www.google.co.in/");
selenium.windowMaximize();

String lc[]=selenium.getAllLinks();
System.out.println("TOTAL NO OF LINKS="+lc.length);

String bc[]=selenium.getAllButtons();
System.out.println("TOTAL NO OF BUTTONS="+bc.length);
String fc[]=selenium.getAllFields();

System.out.println("TOTAL NO OF INPUT FIELDS="+fc.length);

}
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@AfterClass
public void tearDown() throws Exception {
selenium.stop();

seleniumserver.stop();

OUTPUT

TOTAL NO OF LINKS=41
TOTAL NO OF BUTTONS=1
TOTAL NO OF INPUT FIELDS=3

Global Institute of Technology, Jaipur

Page 32



Software Testing Lab Manual

EXPT NO :-9 Write and test a program to get the number of list items in a list /

combo box.

import java.io.Buffered Writer;
import java.io.File;

import java.io.FileWriter;

import com.thoughtworks.selenium.*;
import org.openqga.selenium.server.*;
import org.testng.annotations.”;
public class Dropdowngoogle {

public Selenium selenium;

public SeleniumServer seleniumserver;

@BeforeClass

public void setUp() throws Exception {
RemoteControlConfiguration rc = new RemoteControlConfiguration();
seleniumserver = new SeleniumServer(rc);
selenium = new DefaultSelenium("localhost", 4444, "*firefox", "http://");
seleniumserver.start();
selenium.start();
}
@Test
public void testDropdowngoogle()throws Exception {
selenium.open("http://www.schools9.com/kdiplomal1022011.htm");
selenium.waitForPageToLoad("3000");

String[] option = selenium.getSelectOptions("name=course");

File file = new File("C:/Dropdownvalues.xls");//excel

File filel = new File("C:/Dropdownvalues.txt");//notepad Buffered Writer out
= new BufferedWriter(new FileWriter(file));//excel BufferedWriter outl =

new BufferedWriter(new FileWriter(filel));//notepad out.write("Options in

drop down\n");//Excel
outl.write("Options in drop down\n");//notepad

for (inti=0; i < option.length; i++) {

System.out.println("Option: " +1i+ "is" +

nn

option[i]); out.write(""+option[i]);
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out.newLine();
outl.write(""+option[i]);
outl.newLine();
}
out.close();//excel
outl.close();//notepad
}
@AfterClass
public void tearDown()throws Exception {
selenium.stop();

seleniumserver.stop();

}
}

OUTPUT

}@ = B X s Dropdownvalues.xls - Microsoft Excel - = X
~ Home Insert Page Layout Formulas Data Review View ‘@) -3 X
zj * Calibri -lu A | [E=={®] |5 ||cenera - };_:fll ?}é g %’_“[mm' i %—L? Lﬁ
5 — = 5% Delete ~ || (@]~ B
Paste || B2 | ) (B0 A ]| (M ]2 ][ BB (8- % [0 8)| Conaionsl pormat cen ||y | S sona mnas
Clipboard = Font &= Alignment &= Number & Styles Cells Editing
[ 110 - Q £ |
A B C D E F G H i J K L M N o] Pi
1 Options in drop down
2 |..Sem..
3 1
4 2
5 3 =
6 4 =
7 5
8 6
S 7
10 —1
11
12
13
14
15
4 4 » »| Dropdownvalues %3 [ L m
Ready
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EXPT NO :-10 Write and test a program to count number of check boxes on the

page checked and unchecked count.

package testscripts;
import com.thoughtworks.selenium.*;
import org.openqga.selenium.server.*;

import org.testng.annotations.”;

public class exp8 {
public Selenium selenium;

public SeleniumServer seleniumserver;

@BeforeClass

public void setUp() throws Exception {

RemoteControlConfiguration rc = new RemoteControlConfiguration();
seleniumserver = new SeleniumServer(rc);

selenium = new DefaultSelenium("localhost", 4444, "*firefox","http://");
seleniumserver.start();

selenium.start();

}

@Test

public void testDefault TNG() throws Exception {
selenium.open("http://browsershots.org/");
selenium.windowMaximize();

//Count of check boxes

Number ¢ =selenium.getXpathCount("//input[@type|'checkbox']]");
System.out.println("Count of check boxes " +c);

//Number of check boxes checked

Number d = selenium.getXpathCount("//input[@type='checkbox' and
@checked]");

System.out.println("Count of Checked check boxes " +d);

//Number of check boxes unchecked

Number e = selenium.getXpathCount("//input| @type='checkbox' and
not(@checked)]");

System.out.println("Count of Checked check boxes " +e);
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@AfterClass
public void tearDown() throws Exception {
selenium.stop();

seleniumserver.stop();

OUTPUT
Count of check boxes 127
Count of Checked check boxes 91
Count of Checked check boxes 36
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